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Obtaining Proof of Play 

You need administrator privileges in SV Director to use Proof of Play. 
This document describes how to enable proof of play, create tags for proof of 
play content, generate reports, download CSV files, and troubleshoot proof of 
play processing. 
Proof of play is the ability to generate a report of which advertisements were 
played during an event. Once a proof of play database has been set up, 
StadiumVision Director collects and collates proof of play data from the Cisco 
DMPs and displays it in a proof of play report on the Control Panel. You can 
export the data to a Comma Separated Value (CSV) information file and then 
use a spreadsheet application such as Microsoft Excel to generate reports 
from these CSV files. 
StadiumVision gathers logs from all Cisco DMPs after the event. These logs 
contain, among other things, the content that was played during the event 
and when it was played for example, before the event, during the event, and 
after the event. 
By default, proof of play data is archived for 14 days. Using the SV Director 
Management Dashboard, you can change this setting as well as the time of 
day at which the data is archived.  

Proof of Play Data Compatibility with KORE 
In StadiumVision release 2.2, the format of the proof of play data 
accommodates post processing by KORE Systems. To support KORE data 
processing, SV Director aggregates proof of play data across DMPs and 
generates reports that show information based on total playout per sponsor 
rather than individual playouts per DMP. 

Enabling Proof of Play 
Before proof of play data can be generated, you need to enable the global 
proof of play switch within StadiumVision Director and set the Syslog 
Collector IP Address for the DMP. By default, proof of play is enabled for 
each playlist. However, to generate the data, you must also enable proof of 
play for the associated event script. Refer to the following procedures: 
Enabling the Global Switch for Proof of Play 
Enabling a DMP to Generate Proof of Play Messages 
Enabling/Disabling Proof of Play for a Playlist 



© 2011 Cisco Systems, Inc. All rights reserved. This document is Cisco Internal Information. Page 5 of 28 

Enabling Proof of Play for an Event Script 

Logging in to SV Director 
You need to be logged in to SV Director with administrator credentials to use 
the proof of play function. 
To log in to SV Director: 
1. Open a browser window and type http://ipaddress:8080/StadiumVision/ 

where ipaddress is the IP Address of the SV Director Server. 
2. Enter your SV Director administrator credentials: 

Username: admin 
Password: admin 

Enabling Global Proof of Play 
1. Log in to SV Director and open the Management Dashboard. 
2. Select Tools > Advanced > Registry. 
3. Set the EnableProofOfPlay key to true. By default, it is set to false. 
4. Click Apply. 

Figure 1. Enabling the Global PoP Switch 

 
5. Restart SV Director. 

http://ipaddress:8080/StadiumVision/
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Enabling a DMP to Generate Proof of Play Messages 
To use proof of play, you need to enable the Syslog for the DMP and also set 
the Syslog Collector IP Address. This address is typically the IP address of 
the SV Director. By default, Syslog is not enabled. 
To enable proof of play for a DMP: 
1. Open the Management Dashboard and select the DMP(s) from the 

Device List. To select multiple DMPs, enable the checkbox next to the 
device name. 

2. To view the Syslog settings for a selected DMP, go to the bottom of the 
screen and click Syslog on the Device Settings tab.  

Figure 2. Checking Syslog Settings for the DMP 

 
3. Select Configuration > DMP Commands > Update MIB. 
4. In the Update MIB command parameters box, add the following 

Name:Pair values: 
init.syslog: on 
init.syslog_collector: <IP address of SV Director server> 

5. Click the Play button to send the command to the selected DMP(s). 
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Figure 3. Enabling PoP for a DMP 

 
6. Click Syslog on the Device Settings tab to verify the new settings. 

Enabling/Disabling Proof of Play for a Playlist 
Proof of play for each playlist is enabled by default. However, proof of play 
data will not be generated unless you enable proof of play for the script. 
To disable proof of play for playlist: 
1. Open the Control Panel. 
2. Click the Content tab. 
3. Select a playlist. The playlist settings display in the Playlist Items window. 
4. Enable the No button for Enable Proof of Play. 
5. Click Update. 
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Figure 4. Enabling PoP for a Playlist 

 

Creating a Tag for a Proof of Play Record 

You can create a tag that is assigned to the proof of play record. This allows 
you to tag the records with a label that identifies the advertiser or sponsor. 
To create a tag for a proof of play record: 
1. On the Control Panel Content tab, expand the All Content folder under 

Content Navigation. 
2. Open the By Tag folder. 
3. Click the Add New Tag icon (folder with green plus sign). A New Tag 

entry displays under the By Tag folder. 

Figure 5. Adding a New PoP Tag 
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4. Type the desired tag name, for example, the name of the advertising 
agency. The tag name must use the following naming convention in order 
to be picked up by proof of play: 

<tag name>_PoP 

Note: Do not use following invalid characters such as / ? < > \ : * | " in the tag 
name. 
Note: The "_PoP" after the tag name is not included in the proof of play 
report; only the <tag name> is displayed in the report.  

5. From the Playlist items window, click and drag the content you want to 
assign onto the tag you just created in the Content Navigation window. 
You can assign multiple playlists to the same tag. 
The number of playlists assigned to each tag displays under the # column 
in the Content Navigation window next to the tag name. To find out which 
playlists are assigned to a tag, double-click on the tag name. 

Figure 6. Assigning Playlist Content to a PoP Tag 

 

Enabling Proof of Play for an Event Script 
To limit the amount of data gathered by SV Director, proof of play is enabled 
by default for each playlist, but not for event scripts. To generate proof of play 
data, you must enable it at both levels. 
1. Open the Control Panel and select the Control tab. 
2. Select an event script. 
3. Enable the Proof of Play Yes button for the event script. 
4. Click Run Script. 
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Figure 7. Enabling PoP for an Event Script 

 

Considerations for Generating a Proof of Play Report 
The following diagram shows the workflow for generating a proof of play 
report. 
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Before you generate a proof of play report, consider the following: 

• If the name of the content contains a space, proof of play will not 
recognize it. 

• Proof of play records are not available until the script completes. 

• While the proof of play report is processing, there is a delay between the 
end of an event and the availability of the reports in the Proof of Play 
screen. Click the refresh button before generating and viewing a proof of 
play report to be sure the latest report status is displayed.  

• Depending upon the amount of data you have in the script, it may take 
from 10 seconds to several minutes to generate the report.  

• The last event state is traditionally used to turn off the displays in the 
venue. Because of this, the last state does not offer proof of play data. 

• Content placed in the first event state may not appear in proof of play 
records. 

• For zero-duration non-video items in a playlist, the proof of play record 
will show the airtime when the item started to play and the Duration as 0 
(zero). 

• StadiumVision Director is unable to generate proof of play for an event if 
proof of play is turned on for a Dynamic Menu Board playlist. Therefore, 
before generating a proof of play report, be sure to turn off proof of play 
for all Dynamic Menu Board playlists. 

• Proof of play reports are not generated for playlists that contain less than 
three items. If proof of play is required, create playlists that contain three 
or more items. 

• Custom screen templates do not support proof of play. 

• For proof of play, you can have only one region with an ad playlist. 

Best Practices for Naming and Tagging Content to Generate 
Proof of Play Reports 

Use of a consistent naming strategy makes it easier to generate and manage 
reports. For example, prefixing region 2 content file names with “R2” (e.g.,  
“R2_filename.jpg”) allows you to generate reports on region 2 content since 
filters can be applied to look for “R2” at the head of the string. Other types of 
content should have unique identifiers like “FS” for full screen content and so 
on. 
Additionally, associating proof of play tags to content provides excellent 
metrics for reporting and filtering. Tag names are free form so they can 
reflect an advertiser account number, campaign identifier, or other reporting 
metric. These tags will appear in the KORE CSV file. 
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Naming of groups and zones is equally important as they will be directly 
reflected in the report. A zone name of “Concourses” with group names of 
“Main Hall” and “Section 101” make for easier reading within the report. This 
also makes it possible to generate a useful proof of play report without 
detailed knowledge of how the system is configured. 

Using the Proof of Play Screen 
The Setup > Proof of Play screen in the Control Panel displays the status of 
the collection of data required to demonstrate proof of play. Each entry in the 
window represents an event. 
The Proof of Play screen displays the event name, the start and end time of 
the event, whether the event has finished, and whether the raw data was 
converted to a CSV file. The status column shows the status of each entry. A 
green dot displays in the status column when the report is ready to be 
generated. 
You can download the proof of play data for a specific event by selecting 
download under the CSV column. The CSV file will be downloaded to the 
CSV repository on the SV Director server.  

Figure 8. Proof of Play Screen 

 
Table 6 describes the column headings for the Proof of Play screen. 

Table 6. Proof of Play Screen Headings 

Column Header Description 

Status Script is currently running (orange box), script is completed and PoP data is 
ready to be generated (green circle), PoP report is being generated (yellow 
icon). PoP is complete (yellow icon). 

Script Name Name of the Event Script as specified in StadiumVision Director. This is the 
same for all entries in the CSV. 

Script Run Date Date and time the event script was started on the local server. This is the 
same for all entries in a single CSV. 

Last Report Creation Date the report was last generated. 
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Generating a Proof of Play Report 
1. Select Setup > Proof of Play. 
2. Select an event script row from the Proof of Play screen. 
3. Click Generate Report. 

The date and time of the report generation will display in the Last Report 
Creation column. Also, the Generate Report icon will display in the Status 
column while the CSV file is being generated. 
For long events (several hours), it may take a few moments to finish 
compiling the report. Click on refresh button to get the latest update. 

Note: It is recommended that you generate the proof of play report within six 
weeks of the event. 

Figure 9. Generating a Proof of Play Report 

 

Viewing the Proof of Play Report 
When the proof of play report has finished processing (green status icon), 
click the icon at the bottom of the screen to view the report or logs. 
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Figure 10. Viewing a Proof of Play Report 

 

Downloading the Generated Proof of Play Report to a 
CSV File 

Once the proof of play report has been generated, you can download the 
report to a CSV file. Two formats are supported: 

• Generic: More detailed report 
• KORE: A summary report. 
Note: It is recommended that you download the generated proof of play 
report to a CSV file within 14 days of the event. 
To download a generated proof of play report to a CSV file: 
1. Generate a proof of play report. 
2. On the Setup > Proof of Play screen, double-click on the script for which 

you want to download the generated proof of play data. The following 
dialog box displays: 

 
3. Select the type of report(s) you want to generate and click Get. A dialog 

box displays for you to select where you want to save the CSV file(s). 
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Figure 11. Selecting a Location to Store the Proof of Play Report 

 
4. Specify the location on your local drive where you want to save the CSV 

file and click Save. 
The CSV files will be downloaded to the selected location. If you enabled 
both the Generic and the KORE checkboxes, the Generic file will be 
downloaded first and then the following dialog will display for you to 
download the KORE file. 

 
5. Click OK and select the location where you want to download the KORE 

CSV file. Click Save. 
6. Go to your local drive, navigate to the location where you saved the 

reports, and open the files. The files will open in Excel. 

Data Generated for the Generic CSV File 
The Generic CSV file displays one record for each playlist played on the 
DMP. Therefore, if you have a playlist that played across 20 DMPs, the CSV 
file will show an entry for each DMP. 

Table 7. Example of a Generic Proof of Play CSV File 
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Figure 12. Generic CSV File Data 

Data Description 
Event Date Date of event. 

Script Name Name of the script that generated the PoP report. 

MAC Address MAC address for the DMP that played the content. 

Zone Zone which the DMP is a member of. 

Action Commands to the DMP attached display (reserved). 

Playlist Name Name of playlist for the content. 

Content Tags_PoP Content tags assigned to the content. 

Receive Time Interpolated airtime timestamp by using received time (obsolete) 

Playlist Number Item number in the playlist. 

Cluster ID Identifies the cluster of DMPs that are showing the same screen (internal use only) 

State Start Time the event state was initiated. 

Device Name Name of the DMP. 

Group Group that the DMP is a member of. 

State Name Event script state when the ad played. 

Content File name of the content. 

Playlist Name Name of the playlist. 

Time Played Length of time the ad played out. 

Content Tags_PoP Content tag assigned to the content. 

Airtime Actual time that the ad played out. 

Region Region info in each record of individual content play-out TemplateName plus 
RegionName. 

Seq Number Sequence number beginning at event start increment by ad play. 

Spot ID For internal use only. 

Data Generated for the KORE CSV File 
For KORE data processing, SV Director aggregates proof of play data across 
DMPs and generates reports that show information based on total playout 
per sponsor rather than individual playouts per DMP. Therefore, if you have a 
playlist that played across 20 DMPs, the CSV file will show only one entry. 
The Device Count column displays the number of DMPs that played the 
advertisement. 

Figure 13. Example of a KORE PoP Report 
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Table 8. KORE CSV File Data 

Data Description 
Content File name of the content. 

State Start Timestamp for when the event state started. 

Device Count Number of DMPs on which the content was played. 

Zone Zone which the DMP is a member of. 

Action Commands to the DMP attached display (reserved). 

Time Played How long the content played. 

Airtime Actual time that the ad played out. 

Region Region of the screen template where the content played. 

SeqNum Sequence number beginning at event start increment by ad play. 

Event Date Date of event. 

Script Name Name of event script that played. 

Group Group which the DMP is a member of. 

State Name Name of the event state that was active when the content was displayed. 

Playlist Name Name of the content playlist. 

Content Tags_PoP Tags assigned to the content. 

Receive Interpolated airtime timestamp by using received time (obsolete). 

PlaylistNum Item number in the playlist. 

Processing KORE CSV Files 
The KORE CSV file is the result of post processing the main proof of play file 
and condensing it by collapsing multiple entries with the same time played 
stamp into a single record or row. Once the data set is in this format, it is 
much more manageable (around 5-10 MB for the average event) and can be 
further manipulated in Microsoft Excel. 
The advantage of using desktop software like Microsoft Excel is that it 
provides the ability to share, modify and distribute the information to others 
depending on their needs. By leveraging the inherent functionality of the 
Pivot Table feature in Excel, many views into the KORE CSV data can be 
accomplished. For example you can set filters to view: 

• Only the game states that represent the time period of interest. 

• When and where content played by content file name and any included 
tags. 

• The total number of plays for a piece of content throughout the venue. 

• The total number of plays for a piece of content by specific Group or Zone 
association. 

• The cumulative time a piece of content was displayed throughout the 
venue. 
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• The cumulative time a piece of content was displayed by a specific Group 
or Zone association. 

Generating Pivot Table Reports 
To extract some meaningful information from the proof of play data, you can 
create a PivotTable® report in Microsoft® Excel. A PivotTable is an interactive 
table that automatically extracts, organizes, and summarizes your data. You 
can control how MS Excel summarizes the data—for example, by sum, 
average, or count—without entering a single formula. In a PivotTable report, 
you can quickly: 

• Add or remove categories of data 

• Rearrange the data 

• View a subset of the data 

• Show the details you want 
The following links provide examples of proof of play files that were created 
using the PivotTable® report functionality in Microsoft® Excel. These 
examples are referenced in the following sections of this guide. 

• example_pivot.xlsx – 
http://dl.dropbox.com/u/15928784/example_pivot.xlsx 

• example_min_pivot.xlsx – 
http://dl.dropbox.com/u/15928784/example_min_pivot.xlsx 

When you open the example_pivot.xlsx file, there are four tabs: 

• Example Data Set tab: Default view which shows the entire proof of play 
data set. 

• Total Plays in Venue tab: Displays a basic play count of each ad listed 
by content filename and any associated content tags, detailed by group 
and zone. 

• Summarized Play Time tab: Adds a “Played …” column to each group 
and zone. This column takes the number of plays and multiplies it by the 
length of time the content played to establish a total amount of time the 
content aired per group and zone. 

• Content Time Stamps tab: Lists all the timestamps of proof of play per 
content filename. 

Applying Filters to PivotTables 
You can adjust the proof of play reporting view by applying filters to the 
PivotTable as described here. For more details on working with PivotTables, 
see Appendix A. 

http://dl.dropbox.com/u/15928784/example_pivot.xlsx
http://dl.dropbox.com/u/15928784/example_min_pivot.xlsx
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Time Stamp Filtering 

Since proof of play reporting starts when the event script begins – usually 
before the event – and ends well after the event, you may need to make 
some adjustments to the data to retrieve an accurate accounting of plays 
during the actual event versus the timeframe the event script was running. 
You can do this by setting a filter in the PivotTable so that the proof of play 
report displays only proof of play data for content that displayed during the 
actual event. In the example_pivot.xlsx file, you can set this filter in cell B2. 

In Figure 14, the filter is has been adjusted to remove play information 
outside the duration of the game. Unchecking the “Daily” part of the event 
script activities causes matching proof of play entries to drop from the report. 

Figure 14. Time Stamp Filtering 

  

Content Filtering 

In the example_pivot.xlsx file, cell A7 contains a content filter to trim the 
entire list of content filenames to just the “what” items you are interested in. 
Individual content items can be selected for the report, or a standing pattern 
matching filter can be established for the report. 
In this example, the content filenames that start with “R2” detail the region 2 
advertising content. By setting up a “Begins With” filter in the “By label:” filter 
space with a value of “R2_P”, the report will list only region 2 content. In this 
example, the region 2 content is the team’s self-promotion advertisements. 
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Figure 15. Content Filtering 

 

Group and Zone Filtering 

In the example_pivot.xlsx file, cell B4 contains the Group and Zone filter. This 
filter can have two different standing sets of matches to truly refine the 
“where” of the reporting. They can be used singularly or in combination to 
refine the detail of the report. 
Choose Zone from the “Select field” pull down menu to set a filter that 
displays only the zones of interest in the report. If you check only 
“Concourses”, all other zones in the data set will not be listed in the report. 
Choose Group from the “Select field” pull down menu to set a separate filter 
that displays a subset of the concourse groups of interest in the report. The 
Groups filter is used in conjunction with the Zones filter. 

Figure 16. Group and Zone Filtering 

 

Proof of Play Behavior for In-Progress Events 
Proof of play will not process an in-progress event. If  you select an in-
progress event, the Generate Report tab will be grayed out (unavailable). 
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Removing a Proof of Play Entry 
To save disk space on the server, you can periodically remove old proof of 
play entries that are no longer needed. This operation is IRREVERSIBLE and 
must executed with caution. The operation will fail if you attempt to remove a 
proof of play entry while an event script is running or while a CSV report is 
processing. 
To remove a proof of play entry from the Proof of Play screen: 
1. Select the proof of play entry you want to remove. 
2. Click Delete. 

Figure 17. Deleting a Proof of Play Entry 
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Appendix A: Advanced PoP Procedures 

This appendix provides advanced procedures for working with PivotTables 
and troubleshooting the proof of play module. 

Working with PivotTables 
This section provides instructions for displaying proof of play data in a 
PivotTable. By default the PivotTable displays data in seconds. To change 
the display to minutes, see Changing the Default Data Display to Minutes 
(Advanced). 

Displaying Proof of Play Data in Seconds (Default) 
1. Copy data from the new report (abc123_kore_report.csv) to the example 

file containing the PivotTables (example_pivot.xlsx): 
a. Open the example PivotTable file example _pivot.xlsx 
b. Open the new data file abc123_kore_report.csv 

c. Right-click on the abc123_kore_report.csv tab in the same window and 
choose “Move or Copy…”. The dialog box in Figure 18 displays. 

Figure 18. Creating a Copy Flag 

 
d. From the To book: pull down menu, select example _pivot.xlsx. 
e. Enable the Create a copy checkbox and click OK. 

2. Find the last cell data in the abc123_kore_report.csv tab in the example 
_pivot.xlsx file: 
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a. In the example _pivot.xlsx window with the “abc123_kore_report.csv” 
tab being shown, scroll down to the last row of data. The column will 
be “Q”. (CTL+q is the shortcut). 

b. Locate the last row that contains data and make note of it. In this 
example, it is 28263. 

3. Reset the PivotTable data range to the new sheet: 
a. In the example _pivot.xlsx window click the desired tab: Total Plays in 

Venue, Summarized Play Time, or Content Time Stamps. 
b. Select the rows that you want to include in the PivotTable. This 

updates the MS Excel tool bar. 
c. Select Insert > PivotTable from the tool bar. The Data > PivotTable 

toolset displays in the ribbon menu. Refer to Figure 19. 

Figure 19. PivotTable Toolset 

  
d. Click on the “Change Source” tool in the ribbon. The dialog box shown 

in Figure 20 displays. Note that the information displayed in the dialog 
box will be incorrect as it will reference the Example Data Set tab. 

Figure 20. Change PivotTable Data Source Dialog Box 

 
e. Enter the Location for the data set. Follow this string format with the 

tab that contains the data set and the row value obtained in step 2b: 
 
'abc123_kore_report.csv'!$A$1:$Q$28263 
 

f. Click OK. 
4. Repeat Step 3 to update the other sheets within the PivotTable file. 
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5. Save the modified template example_pivot.xlsx file as a .xlsx formatted 
file with a new name so as not to overwrite the example. 

6. You can delete the sample Example Data Set tab to reduce the file size. 
Simply right click on the tab and choose Delete. 

Changing the Default Data Display to Minutes (Advanced) 
To change the default data display from seconds to minutes, you need to add 
a column to the data set as described here. 
1. Copy data from the new report (abc123_kore_report.csv) to the example 

file containing the PivotTables (example_min_pivot.xlsx). 
a. Open the example PivotTable file example_ min_pivot.xlsx. 
b. Open the new data file abc123_kore_report.csv. 

c. Right-click on the abc123_kore_report.csv tab in same window and 
select Move or Copy… The dialog box shown in Figure 21 displays. 

Figure 21. Changing the default data display from seconds to minutes 

 

2. From the To book: drop down box, select example_min_pivot.xlsx. 
3. Enable the Create a copy checkbox and click OK. 
4. Locate the last cell data in the abc123_kore_report.csv tab in the 

example_min_pivot.xlsx file: 
a. In the example_ min _pivot.xlsx window with the 

“abc123_kore_report.csv” tab displayed, scroll down to the last row of 
data. The column will be “Q”. (CTL+q is the shortcut), 

b. Locate the last row that contains data make note of the value. In this 
example, the value is 28263. 

5. Add a new minutes column to the data set: 
a. In the example_min_pivot.xlsx window with the 

“abc123_kore_report.csv” tab displayed, add “Min Played” to cell R1. 
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b. Add “=SUM(K2/60)” to cell R2 

 
c. Duplicate R2 to every R cell until the last cell row of the sheet, 28263 

in this example. (CTL+c on R2, click on R3, scroll to 28263, Shift-click 
on R28263, then a CTL+v). 

6. Reset the PivotTable data range to the new sheet: 
a. In the example _min_pivot.xlsx window click the desired tab: Total 

Plays in Venue, Summarized Play Time, or Content Time Stamps. 
b. Select the rows that you want to include in the PivotTable. This 

updates the MS Excel tool bar. 
c. Select Insert > PivotTable from the tool bar. The Data > PivotTable 

toolset displays in the ribbon menu. 

Figure 22. PivotTable Tool Set 

 

d. Click on the Change Source tool in the ribbon. The following dialog 
box displays. Note that the information in the dialog box will be 
incorrect as it will reference the Example Data Set tab. 

Figure 23. Change PivotTable Data Source Dialog Box 

 
e. Edit the Location field to point to the location of the data set. Follow 

this string format with the tab that contains the data set and the row 
value obtained in step 3 being different: 
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'abc123_kore_report.csv'!$A$1:$R$28263 
 

f. Click OK. 
 

7. Repeat step 4 to update the other data sheets. 
8. Save the modified template example_min_pivot.xlsx file as a .xlsx 

formatted file with a new name so as not to overwrite the example. 
9. If desired, delete the sample Example Data Set tab to reduce the file 

size. Simply, right click on the tab and choose Delete. 

Troubleshooting the Proof of Play Module 
Important! This section contains information for Cisco Technical Support 
engineers and may contain internal knowledge that is not suitable for 
releasing to the customer.  

Internal Registry Values 
Table 9. Internal Registry Values 

Registry Entry Value/Description 
EnableProofOfPlay Enables the proof of play module. Requires restart tomcat for changes to take effect.  

PofPDaysToKeep  Number of days that the raw syslog keeps in the database. Default is 14 days.  

pop.tool Link to the external CSV report processing tool.  

pop.maxQSize The maximum incoming syslog messages kept in the queue before overflowing to 
the file, svlog.dmp.syslog.log. Default = 1,000,000. 

pop.monitorQSize The number of incoming syslog messages that are received before the proof of play 
monitor checks the queue size. This is for debug purposes only. Default =10,000. 

pop.sqlQueryLimit The maximum number of SQL query entries that can be received simultaneously for 
query mysql. The query mysql should be done in batches to reduce heap memory 
usage. Default =10,000. 

Troubleshooting Report Status Not Green 
If the proof of play report status is not green after an event completes, it is 
critical that you resolve the situation quickly before the script or contents get 
changed.  
1. Find the script cookie: 

a. On the Control Panel, click the Setup > Proof of Play tab. 
b. Mouse over the event script row to display the name of the script 

cookie. 
2. Get proof of play object information:  

http://yourServerIP:8080/StadiumVision/config/views/popInfo 
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This will return XML as follows:  
<popInfos> 
<popInfo> 
  <id>7</id>  
  <popStateInfos />  
  <startTime class="sql-timestamp">2010-07-05 09:58:31.0</startTime>  
  <endTime class="sql-timestamp">2010-07-05 10:02:11.0</endTime>  
  <scriptName>4310_test_pop</scriptName>  
  <scriptCookie>430-MMg83</scriptCookie>  
  <scriptId>430</scriptId>  
  <finished>true</finished>  
  <processed>true</processed>  
  <scriptSnapshot>true</scriptSnapshot>  
  <statesLog>true</statesLog>  
  <rawData>true</rawData> 
  </popInfo> 
  </popInfos> 

3. Find the object with the same script cookie and look at the "finished", 
"scriptSnapshot", "stateLog", and "rawData" entries. If any one of these 
fields are not set to true, the status will not be green.  

Updating the Report Status Green Settings 

1. To set the "scriptSnapshot" and "stateLog" to true, go to the following 
URL:  
http://yourServerIP:8080/StadiumVision/pofp/snapshot/<script cookie> 

2. To set the "rawData" to true, go to the following URL.  
http://yourServerIP:8080/StadiumVision/pofp/rawdata/<script cookie> 

The status indicator should turn green after the operation is finished.  

Locating the Proof of Play Files on the SV Director 
Server 

All proof of play data files are stored in the /var/sv/pofp/data/"script cookie" 
directory.  

genData.csv 
koreData.csv  <== KORE report 
process.log   
rawData.csv   
snapshot.XML   
states.XML 

There is also a nightly data dump from the raw data database table. The 
dump files are stored in the /var/sv/pofp/dbDump directory.  
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Backing Up Proof of Play Data 
The proof of play data in the /var/sv/pofp/data directory gets backed up as 
part of the nightly backup.  
The dbDump files in the /var/sv/pofp/dbDump directory will be removed from 
the disk after 60 days.  

Cleaning Up Proof of Play Data 
At the end of season, clean up all proof of play data as follows.  
1. Clean up proof of play data on the disk. 

You can remove directories and internal data from previous SV Director 
releases (prior to R2.2). This data is stored in the directory as 
"/var/sv/pofp/YYYYMMDD". However, DO NOT remove the 
"/var/sv/pofp/bin" directory. This is where the CSV report tool is located 
for Release 2.2.x. 

Table 10. Cleaning up data on the disk (release 2.2 and beyond) 

Directory Description 
/var/sv/pofp/data This is the actual data for each game. You may want to keep a backup copy. 

/var/sv/pofp/dbDump This is a daily database dump from the database and does not need to be saved. 
However, DO NOT delete the  directory itself. 

2. Clean up proof of play data in the database. 
There are no links between the iapps_pofp and the iapps_1 databases. 
Therefore, once these databases are backed up, you can remove entries 
in the following tables. 

Table 11. Cleaning up data in the database 

Database Tables Description 
iapps_pofp pofp_data 

pofp_script 
pofp_state 

The pofp_data table does not have any foreign key constraints. The 
pofp_state table entries should removed before removing entries in 
the pofp_script table.  

iapps_1 x_popstateinfo 
x_popinfo 

Remove all entries in these tables. 
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